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Introduction and workflow overview

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

This guide describes the OpenArray™ plate high-throughput, sample-to-result
workflow for vaginal microbiota profiling. The workflow uses:
e OpenArray™ plates with TagMan® Assays for vaginal microbiota profiling

* QuantStudio™ 12K Flex instrument with OpenArray™ block (AccuFill™ System)

Vaginal microbiota profiling

Microorganism-specific TagMan® Assays offer a rapid and accurate approach to
investigate and monitor vaginal microbiome composition and dynamics.

We offer a collection of qualified TagMan® Assays (see “TagMan® Assays for vaginal
microbiota profiling” on page 7 ) that have been optimized for detection of vaginal
microbes. The TagMan® Assays designs and their target sequences have undergone
rigorous bioinformatics selection and analysis to ensure maximum strain coverage
while minimizing the potential for off-target cross-reactivity. Qualified TagMan®
Assays for vaginal microbiota profiling demonstrate accurate, reproducible
performance in multiple rounds of testing for sensitivity and specificity. The assays
perform well with DNA isolated from vaginal samples using optimized MagMAX"™
DNA Multi-Sample Ultra Kit protocols.

Additional TagMan® Assays for microbial targets are available from our predesigned
assay collection or can be ordered through the Custom TagMan® Assays Design Tool.

Workflow: TaqMan® vaginal microbiota profiling experiments

Collect vaginal sample using a compatible system or media (see page 12)
v

Chapter 3, “Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit"
v

Chapter 4, “Prepare and run vaginal microbiota profiling experiments with
OpenArray” plates”

v

Chapter 5, “Export and review vaginal microbiota profiling data”
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Background and tools for assay
content selection

B TagMan® ASSays .. ...ttt 7
B TagMan® Assays for vaginal microbiota profiling .......................... 7
B (Optional) Reference and controlassays ...............ooviiiiiiiioo.... 9
®  OpenArray™ plate products and formats ............... .. ... .. ... 9
®m Configure and order custom TagMan® OpenArray™ plates ................ 10

TagMan® Assays

TagMan® Assays for vaginal microbiota profiling consist of a pair of unlabeled PCR

primers and a TagMan® probe with a FAM™ dye label on the 5' end and minor groove
binder (MGB) and nonfluorescent quencher (NFQ) on the 3' end.

For more information about real-time PCR and TagMan® Assays, visit
thermofisher.com/qpcreducation.

TagMan® Assays for vaginal microbiota profiling

OpenArray' plates can be configured with the following TagMan® Assays.

For more information about available TaqMan® Assays for vaginal microbiota
profiling, visit www.thermofisher.com/vm.

Table 1 TagMan® Assays for vaginal microbiota profiling

Assay ID Classification Organism
Ba04646222_s1 Bacteria Atopobium vaginae
Ba04646225_s1 Bacteria Bacteroides fragilis
Ba04646229 s1 Bacteria BVABZ2
Ba04646249_s1 Bacteria Chlamydia trachomatis
Ba04646247 s1 Bacteria Enterococcus faecalis
Ba04646242 s Bacteria Escherichia coli
Ba04646236_s1 Bacteria Gardnerella vaginalis
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Chapter 2 Background and tools for assay content selection
TagMan® Assays for vaginal microbiota profiling

Assay ID Classification Organism
Ba04646228_s1 Bacteria Haemophilus ducreyi
Ba04646245_s1 Bacteria Lactobacillus crispatus
Ba04646234_s1 Bacteria Lactobacillus gasseri
Ba04646257 s1 Bacteria Lactobacillus iners
Ba04646258_s1 Bacteria Lactobacillus jensenii
Ba04646230_s1 Bacteria Megasphera 1
Ba04646231_s1 Bacteria Megasphera 2
Ba04646235 s1 Bacteria Mobiluncus curtisii
Ba04646246 s Bacteria Mobiluncus mulieris
Ba04646251_s1 Bacteria Mycoplasma genitalium
Ba04646255_s1 Bacteria Mycoplasma hominis
Ba04646252_s1 Bacteria Neisseria gonorrhoeae
Ba04646278_s1 Bacteria Prevotella bivia
Ba04646259_s1 Bacteria Staphylococcus aureus
Ba04646276_s1 Bacteria Streptococcus agalactiae (group B)
Ba04646237_s1 Bacteria Treponema pallidum (Syphilis)
Ba04646254_s1 Bacteria Ureaplasma urealyticum
Fn04646233_s1 Fungi Candida albicans
Fn04646244_s1 Fungi Candida dubliniensis
Fn04646240_s1 Fungi Candida glabrata
Fn04646250_s1 Fungi Candida kruser
Fn04646241_s1 Fungi Candida lusitaniae
Fn04646221_s1 Fungi Candida parapsilosis
Fn04646220_s1 Fungi Candida tropicalis
Pr04646256_s1 Protozoa Trichomonas vaginalis
Vi04230116_s1 Virus HSV1
Vi04646232_s1 Virus HSV2
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Chapter 2 Background and tools for assay content selection
(Optional] Reference and control assays

(Optional) Reference and control assays

The following optional TagMan® Assays are available as reference or control assays,
including prokaryotic 165 rRNA and the human RNase P RPPH1 gene. These assays
can be used in relative quantification applications and to assess the adequacy of the
human sample.

Table 2 Optional TagMan® Assays for vaginal microbiota profiling experiments

Assay ID Target Application

Ba04930791_s1 Prokaryotic 165 rRNA | Relative quantification/normalization to
bacterial DNA

Hs04930436_g1 Human RNase P * Relative quantification/normalization
RPPH1 gene to human DNA

e To assess adequacy of the sample

Optional controls The TaqMan® Vaginal Microbiota Amplification Control contains target sequences for
each vaginal microbiota assay as well as control prokaryotic 165 rRNA and human
RNase P RPPH1 gene sequences. This amplification control can optionally be
included in vaginal microbiota profiling experiments to verify assay performance and
to assist with troubleshooting.

For ordering information, email QuantStudioFrontDesk@lifetech.com.

OpenArray  plate products and formats

TagMan® OpenArray  plates contain pre-plated, dried down TagMan® Assays for
vaginal microbiota profiling.

Array format Number of assays Number of samples
18 18 48
56 56 48
112 112 24

Vaginal Microbiota Profiling Experiments Application Guide 9
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Chapter 2 Background and tools for assay content selection
Configure and order custom TagMan® OpenArray™ plates

Configure and order custom TagMan® OpenArray  plates

1. Go to www.thermofisher.com/order/custom-array/.

2. For array type, select TagMan® OpenArray " Real-Time PCR Inventoried
Assays Format.

3. Click Select to configure a plate.

4. Enter the custom array name in the Array name text field.

5. Click Import Your Assay List, then provide assay information:

* Under Upload a list of Assay IDs, click Choose File, then select a tab-
delimited text file (.txt) containing Assay IDs.

or

¢ Under Enter a list of Assay IDs, paste the Assay IDs, then click Import
Entered List.

6. Follow the screen instructions to configure the assays on the plate.

7. (Optional) Click Save Your Array at any time to save the array configuration to
your Thermo Fisher Scientific account.

8. When the plate is configured, click Complete Your Design, then follow the
screen instructions to complete the order.
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Isolate DNA using the MagMAX"™
DNA Multi-Sample Ultra Kit
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IMPORTANT! Samples collected using the Hologic™ Aptima™ Vaginal Swab
Transport Media (STM) require minor modifications to the DNA isolation procedure
(see Appendix B, “Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit:
Hologic™ Aptima™ media”).
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Compatible sample collection systems or media

Compatible sample collection systems or media

The following sample collection systems and media are compatible with the
procedures described in this guide.

See the collection system or media documentation provided by the manufacturer for
information on sample collection and storage.

Sample collection system / media Source
ThinPrep™ Pap test Hologic™
BD SurePath™ test BD"

ESwab " [1.3] Copan Diagnostics™
Aptima™ Vaginal Swab Transport Media (STM)!Z] Hologic™

M4™ MicroTest 13l Remel”
Affirm Ambient Temperature Transport System BD"

BD ProbeTec™ Swab diluent Q* BD™

01 |f samples appear dense or cloudy or have been stored >48 hours, see Appendix A, “Troubleshooting”.

[2I' Samples require minor modifications to the DNA isolation procedure; see Appendix B, “Isolate DNA using the
MagMAX™ DNA Multi-Sample Ultra Kit: Hologic™ Aptima™ media”.

BI' Process samples within 48 hours of collection.

Contents and storage

12

Cat. No. Cat. No.
Contents A25597 A25598 Storage
(500 rxns) (2,500 rxns)
Proteinase K 4 mL 5x4mL -25°C to -15°C
PK Buffer 96 mL 5x 96 mL
15°C to 30°C
Multi-Sample DNA Lysis Buffer 100 mL 5x 100 mL
DNA Binding Beads 8 mL 5x8mL 2°Cto 8°C
RNase A 2x1.25mL 10x1.25mL -25°C to -15°C
Nuclease-free Water 100 mL 5x 100 mL
Wash Solution 1 Concentratel] 80 mL 5x 80 mL
Wash Solution 2 Concentratel] 162 mL 5x 162 mL 15°C to 30°C
DNA Elution Buffer 1 25 mL 5x25mL
DNA Elution Buffer 2 25 mL 5x25mL

(1 Before use of the kit, prepare all applicable wash solutions as described on their bottles and in this protocol.
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Required materials not supplied

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (www.fisherscientific.com) or other major laboratory supplier.

Table 3 Required materials and equipment not included with the kit

Item Source
One of the following instruments
[Recommended] KingFisher™ Flex Magnetic Particle Processor 5400630
MagMAX™ Express-96 Magnetic Particle Processor —m
Equipment
Plate shaker, capable of shaking plates at a minimum of 900 rpm 88880023

Analog Vortex Mixer

Fisher Scientific

02-215-365
Adjustable micropipettors MLS
Multi-channel micropipettors MLS
(Optional/Magnetic Stand-96 AM10027
Plates and combs
Deep Well Plates, one of the following:
KingFisher™ Flex Microtiter Deepwell 96 plates, sterile 95040460
MagMAX"™ Express-96 Deep Well Plates 4388476
Standard Well Plates, one of the following:
KingFisher™ 96 KF microplates 97002540
MagMAX" Express-96 Standard Plates 4388475
Tip Combs, one of the following:
KingFisher™ 96 tip comb for DW magnets 97002534
MagMAX™ Express-96 Deep Well Tip Combs 4388487
Other consumables
MicroAmp™ Clear Adhesive Film 4306311
RNase-free Microfuge Tubes (2.0 mL]) AM12425
Conical tubes (15 mL) AM12500
Conical tubes (50 mL]) AM12502
Aerosol-resistant pipette tips MLS

Vaginal Microbiota Profiling Experiments Application Guide
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Required materials not supplied

Item Source
Reagent reservoirs MLS
(Optional] Paraffin film MLS
Reagents
Ethanol, 200 proof (absolute) MLS
Isopropanol, 100% (molecular grade or higher]) MLS

1" Not available for sale.

Table 4 Additional materials and equipment required for processing vaginal samples

Item Source

Fisher Scientific

Centrifuge, capable of spinning deep-well plates at 2,250 x g 75-412-452
Laboratory incubator with slatted shelves, capable of maintaining
o MLS
65°C
B-PER™ Bacterial Protein Extraction Reagent 78243
Lysozyme Solution P1-90082
Fisher Scientific
Zymolyase 50-444-504
Download the The program required for this protocol is not pre-installed on the KingFishefm Flex
KingFi sher " Flex Magnetic Particle Processor.
program 1. On the MagMAX"™ DNA Multi-Sample Ultra Kit web page, scroll down to the

([if needed) Product Literature section.
2. Click A25597_Vaginal to download the program to your computer.
3. See Thermo Scientific™ KingFisher™ Flex User Manual (Cat. No. N07669) and

BindIt™ Software User Manual (Cat. No. N07974) for instructions for installing the
program on the instrument.

14 Vaginal Microbiota Profiling Experiments Application Guide




Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Procedural guidelines

Procedural guidelines

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

* See the collection system or media documentation provided by the manufacturer
for information on sample collection and storage.

¢ Perform all steps at room temperature (20-25°C) unless otherwise noted.
* Preheat an incubator to 65°C before each use of the kit.
* When mixing samples by pipetting up and down, avoid creating bubbles.

¢ Cover the plate during the incubation and shaking steps to prevent spill-over and
cross-contamination. The same MicroAmp"™ Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.

¢ If you use a plate shaker other than the recommended shaker, verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

¢ To prevent evaporation and contamination, cover the prepared processing plates
with paraffin film until they are loaded into the instrument.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and
add 5% overage.

¢ For convenience, you can extend the Proteinase K digestion to 30 minutes.

Before first use of the kit

* Prepare the Wash Solutions from the concentrates:

— Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at
room temperature.

— Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at
room temperature.

* Reconstitute the zymolyase with 500 uL of the provided storage buffer (final
concentration of 4 U/uL), vortex to mix, then store at —20°C.

See the documentation provided with the zymolyase for more information.
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit

Set up the sample layout

Set up the sample layout

Set up the sample plate layout, which provides sample tracking from the 96-well plate
used for DNA isolation to the 96-well sample plate *.csv file used for import into the

™

OpenArray™ Sample Tracker Software.

Note: We recommend three technical replicates of each reaction.

Tool Source Description
96-well Sample gn thzcommpgteroln Y\r/hlctth(;f . lContalnsba sample
Plate 1.csvtemplate _F’f”urgay ample Tracker Software Is | layout tab.

installed:

C:\Program Files\Applied
Biosytems\Sample Tracking
Utility\examples

Concentrate the samples

1.

Gently shake or swirl the sample contents to ensure thorough mixing of the
sample.

Following the sample layout, transfer up to 1 mL of sample to the appropriate
wells of a deep-well plate.

Seal the plate with a clear adhesive film, then centrifuge for 15 minutes at
2,250 x g to concentrate the samples.

After centrifugation, carefully remove and discard as much supernatant as
possible without disturbing the pellet.

Note: You can leave up to 100 pL of supernatant, especially if there is no pellet.

Digest the samples with the Preliminary Digestion Mix

1.

16

Prepare sufficient Preliminary Digestion Mix according to the following table.

IMPORTANT! Prepare the Preliminary Digestion Mix no more than 30 minutes
before use and store on ice. Prolonged storage at room temperature can reduce
its efficiency.

Component Volume per well | Volume per plate
B-PER™ Bacterial Protein Extraction 185 L 18.5 mL
Reagent
Lysozyme Solution 10 L 1T mL
Zymolyase solution (4 U/pL) 5uL 0.5mL
Total Preliminary Digestion Mix 200 pL 20 mL
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Digest the samples with Proteinase K

2. Add 200 pL of Preliminary Digestion Mix to each sample well.

(Optional) Mix by pipetting up and down 5 to 10 times to disperse large pellets.
Seal the plate with a clear adhesive film, then shake for 2 minutes at 1,050 rpm.

Incubate the plate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

During the incubation, prepare the PK Mix (next section).

Digest the samples with Proteinase K

1.

Prepare sufficient PK Mix according to the following table, then invert several
times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix no more than 30 minutes before use and store
at room temperature. Do not place PK Buffer or PK Mix on ice, to avoid
precipitation.

Component Volume per well Volume per plate
Proteinase K 8 uL 0.8 mL
PK Buffer 42 uL 4.2 mL
Total PK Mix 50 uL 5.0 mL

When the incubation with Preliminary Digestion Mix is complete, add 50 uL of
PK Mix to each sample well of the plate.

Seal the plate with a clear adhesive film, then shake the sealed plate for 2 minutes
at 1,050 rpm.

Incubate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

Vaginal Microbiota Profiling Experiments Application Guide 17



Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit

Set up the processing plates

Set up the processing plates

. While the samples are incubating at 65°C, set up the Wash, Elution, and Tip

Comb Plates outside the instrument as described in the following table.

Plate ID po:ilt&ilct::m Plate type Reagent Volt‘an:lalper
Wash Plate 1 2 Deep Well Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well Wash Solution 2 150 pL
Wash Plate 3 4 Deep Well Wash Solution 2 150 pL

s | s | OB o

Tip Comb 6 Deep Well Place a tip comb in the plate.

01 Position on the instrument

21 The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with
DNA Elution Buffer 1.

. (Optional) To prevent evaporation and contamination, cover the prepared

processing plates with paraffin film until they are loaded into the instrument.

Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix, and

isopropanol

18

. (Optional) If condensation is present at the end of the 65°C incubation, briefly

centrifuge the plate for 1-2 minutes at 1,500 x g.

. Prepare sufficient Bead/RNase A Mix according to the following table.

IMPORTANT! Prepare the Bead/RNase A Mix no more than 1 hour before use
and store on ice. Prolonged storage at room temperature can reduce its efficiency.

Vortex the DNA Binding Beads at moderate speed to form a uniform suspension
before preparing the Bead/RNase A Mix.

Component Volume per well Volume per plate
DNA Binding Beads 16 uL 1.6 mL
RNase A 5puL 0.5mL
Nuclease-free Water 19 pL 1.9 mL
Total Bead/RNase A Mix 40 L 4.0 mL

3. Add 125 uL of Multi-Sample DNA Lysis Buffer to each sample.
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4.

5.

Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit

Process samples on the instrument

Vortex the Bead/RNase A Mix at moderate speed to ensure thorough mixing,
then add 40 pL to each sample.

If you see that the beads in the Bead/RNase A Mix are settling, vortex the mix
again briefly before continuing to pipette.

Add 200 pL of isopropanol to each sample, then proceed immediately to process
the samples on the instrument (next section).

Process samples on the instrument

1.

Select the program on the instrument.

* KingFisher™ Flex Magnetic Particle Processor: A25597_Vaginal
* MagMAX"™ Express-96 Magnetic Particle Processor: 4413021_DW_blood

Start the run, remove the temporary paraffin plate seals (if present), then load the
prepared processing plates in their positions when prompted by the instrument.

Load the sample plate (containing lysate, isopropanol, and Bead/RNase A Mix)
at position 1 when prompted by the instrument.

When prompted by the instrument (approximately 25 minutes after initial start):
a. Remove the Elution Plate from the instrument.

b. Add 30 pL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.

At the end of the run (approximately 30 minutes after initial start), remove the
Elution Plate from the instrument and seal immediately with a new clear
adhesive film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

* If you see excessive bead residue in the wells, place the Elution Plate on the

Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

e At 2-6°C for up to 24 hours.
* At -20°C or -80°C for long-term storage.
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Prepare and run vaginal microbiota

profiling experiments with
OpenArray plates

Workflow: Microbiota profiling experiments with OpenArray™ plates . .. ... 21
Required materials for OpenArray™ plate workflow ...................... 22
Generate 384-well sample plate layouts in the OpenArray™ Sample

Tracker Software ........ ... ... . 23
Set up the PCR reactions in an OpenArray ™ 384-well Sample Plate ......... 24
Set up the AccuFill™ instrument ......... ... .. ... ... ... ... oL 25
Transfer reactions to the OpenArray™ plate (AccuFill™ instrument) ......... 26
Seal the OpenArray™ plate ....... ... ... ... i 27
Run the OpenArray™ plate(s) on the QuantStudio™ 12K Flex instrument . ... 28
Checkthe QCimages ......... ... ... .. . 29
Recover from layout errors in the 384-well sample plate ................... 30
One-time procedures ............... ... ... 30

This chapter describes how to run profiling experiments with custom OpenArray™
plates using a QuantStudio™ 12K Flex Real-Time PCR System.

This chapter contains brief procedures. For detailed procedures, see the following
documentation.

Document Pub. No.

QuantStudio™ 12K Flex Real-Time PCR System:

OpenArray” Experiments User Guide 4470935
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” AccuFill" System User Guide 4456986
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
Workflow: Microbiota profiling experiments with OpenArray™ plates

Workflow: Microbiota profiling experiments with OpenArray  plates

“Generate 384-well sample plate layouts in

Genomic DNA S
(see page 11) the OpenArray = Sample Tracker
Software” on page 23
v v

“Set up the PCR reactions in an OpenArray” 384-well Sample Plate” on page 24

v
“Set up the AccuFill™ instrument” on page 25

v

“Transfer reactions to the OpenArrayW plate (AccuFill™ instrument)” on page 26
v

“Seal the OpenArray" plate” on page 27
v
“Run the OpenArray” plate(s) on the QuantStudio” 12K Flex instrument” on page 28
v
“Check the QC images” on page 29

v

Chapter 5, “Export and review vaginal microbiota profiling data”
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
Required materials for OpenArray™ plate workflow

Required materials for OpenArray  plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com.

MLS: Fisher Scientific (www.fisherscientific.com) or other major laboratory supplier.

Item Source

Instruments, software, and equipment

OpenArray” Sample Tracker Software e

QuantStudio” 12K Flex OpenArray” Plate Press 2.0 A24945
QuantStudio 12K Flex instrument with OpenArray ~ block (AccuFill 4471090
System)

Centrifuge, capable of spinning sample plates at 1,000 rpm MLS

Plates and accessories

OpenArray " 384-well Sample Plates, black 4482221
Biomek " Seal and Sample Foil Lids Beckmanr)
(for pre-plating step) Coulter
538619
OpenArray” AccuFill™ System Tips 4458107
QuantStudio™ 12K Flex OpenArray™ Accessories Kit!?! 4469576
Forceps MLS
Reagents
Genomic DNA See page 11
OpenArray™ plates with TagMan® Assays Custom ordered!
TagMan® OpenArray” Real-Time PCR Master Mix 4462164
Ethanol MLS

1 Included with the QuantStudio™ 12K Flex Software.

21 Each kit contains the items needed to assemble up to 10 plates: 12 lids and plugs, 12 immersion fluid
syringes, and 2 carriers. Each custom OpenArray™ plate is shipped with an accessories kit.

Bl See “Configure and order custom TagMan® OpenArray"™ plates” on page 10.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates

Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker Soft-
ware

Generate 384-well sample plate layouts in the OpenArray  Sample

Tracker Software

The software maps samples from the 96-well layout used for DNA isolation to a
384-well sample plate layout as *.csv files that are used by OpenArray ~ AccuFill™
software.

See “One-time procedures” on page 30 to:

6.

Set up optimized folder locations and software preferences before performing
this procedure for the first time.

Download the *.tpf file(s) for the OpenArray " plate(s) before starting.

. Generate the 96-well sample plate *.csv file using the 96-Well Sample Plate 1.csv

template, then save it to the Sample Tracker 96-well Input folder.

The 96-Well Sample Plate 1.csv file is provided in the AccuFill™ software
installation. Enter or copy the sample names in 96-Well Sample Plate 1.csv, then
Save as a new *.csv-format file.

Note: We recommend three technical replicates of each reaction.

In the Sample Tracker Software Properties screen, select Gene Expression for
Experiment Type, then select the appropriate settings for OpenArray ™ Plate and
Pipettor.

In the Samples screen, click Import, then select and import the sample *.csv
file.

In the Sample Mapping screen, confirm that the samples for a single OpenArray ™
plate are assigned to one color.

™

If necessary, correct the OpenArray " Plate and Pipettor settings in the Properties
screen.

In the Sample Mapping screen, click the 384-Well Plate tab, then click
Export » Export *.csv.

Select 384-Well Plate (for AccuFill), then save the exported file.

Plate layouts for the 384-well sample plates are saved to individual *.csv files in the
Sample Tracker 384-well CSV Files folder.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments

with OpenArray™ plates

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

Set up the PCR reactions in an OpenArray  384-well Sample Plate

IMPORTANT! The 4 x 12 area(s) of the 384-well plate being filled must match the
area(s) designated in the OpenArray ~ Sample Tracker Software for that set of

samples.

1. Remove the OpenArray™ plate from the freezer and allow it to thaw in its sleeve,
unopened, at room temperature (~15 minutes).

The OpenArray™ plate must be completely thawed before transferring reactions
to it from the 384-well sample plate.

2. Gently shake the bottle of TagMan® OpenArray™ Real-Time PCR Master Mix to
thoroughly mix the contents. Do not invert the bottle.

3. Following the plate layout designated in the OpenArray™ Sample Tracker
Software, add master mix, then DNA samples, to the wells of an OpenArray™

384-well Sample Plate.

OpenArray" Plate Format
18 56 1121
Component
Volume Volume Volume
per well per well per well
TaqMan® OpenArraym Real-
Time PCR Master Mix 2:5uL 251k 251k
DNA sample 2.5pL 2.5l 2.5k
Total reaction volume 5.0 uL 5.0 uL 5.0 uL

5.

01 For the 112-format, the OpenArray™ Sample Tracker Software designates two wells for each sample.

Seal the plate with an aluminum foil seal, remove the foil flap, mark the edges of
the filled 4 x 12 area with a pen, then score the foil along those lines.

Do not remove the foil from the scored area at this time.

Centrifuge the plate for 1 minute at 1,000 rpm.

If you make a sample layout error:

24

Before the AccuFill " procedure — Repeat “Generate 384-well sample plate layouts
in the OpenArray " Sample Tracker Software” on page 23 with a corrected
sample.csv file.

After the AccuFill" procedure — See “Recover from layout errors in the 384-well
sample plate” on page 30.
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with OpenArray™ plates
Set up the AccuFill™ instrument

Set up the AccuFill " instrument

IMPORTANT! Before proceeding, check the tip expiration date (shown on the outer
box that contains the trays of tips). Do not use tips that exceed the expiration date.

1. In the OpenArray™ AccuFill™ software, click Setup and Load.

2. In the Setup Load Information window, verify that the Use Sample Integration
checkbox is selected.

3. Click Browse to the right of Sample Plate, then select the 384-well sample plate
*.csv file that was generated with the OpenArray™ Sample Tracker Software.

4. Click Browse to the right of the plate holder position corresponding to the

OpenArray™ of interest, then select the *.tpf file corresponding to the desired
OpenArray™ plate.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments

with OpenArray™ plates

Transfer reactions to the OpenArray™ plate [AccuFill™ instrument]

5.

Click the corresponding 4 x 12 area of the 384-well plate, then click Next to open
the Setup Deck window.

Ensure that:

* Tip boxes are loaded in the AccuFill™ instrument in the displayed
configuration.

* Lids are removed from the tip boxes.

¢ The waste bin in the instrument is emptied.

In the Setup Deck window, select:
* The tips are configured as shown above
* The Waste Bin is empty

Transfer reactions to the OpenArray  plate (AccuFill” instrument)

Ensure that the OpenArray  plate is thoroughly thawed before starting this
procedure.

1.

26

Prepare the items needed to seal the OpenArray™ plate (next section).

Note: The OpenArray™ plate must be sealed promptly after being loaded with
the reactions (this section).

™ ™

a. Ensure that the QuantStudio™ 12K Flex OpenArray " Plate Press 2.0 is ready.

b. Gather and remove from packaging an OpenArray™ lid, plug, syringe with
OpenArray™ Immersion Fluid, and syringe tip.

c. Attach the syringe tip to the syringe and carefully push some of the fluid
through the tip to remove air bubbles, then lay the syringe aside.

Remove the OpenArray ™ plate from its sleeve and place it in the plate holder of
the AccuFill™ instrument.

Ensure that the bar code on the OpenArray™ plate is facing left and the serial
number is facing right.

Using forceps, peel the foil from the filled area of the OpenArray™ 384-well
Sample Plate.

Close the instrument door.

In the AccuFill™ software Setup Deck window, select the following
confirmations, then click Load.

* The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate

As soon as the Remove OpenArray Plate window appears, open the instrument

door, then remove the loaded OpenArray ™ plate.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
Seal the OpenArray™ plate

Proceed immediately to seal the OpenArray™ plate (next section).

Note: For best results, seal the OpenArray™ plate within 90 seconds of
completion of loading, to prevent evaporation.

Seal the OpenArray  plate

IMPORTANT! Handle the OpenArray  plate and case only by the edges throughout
this procedure.

1.

2.

3.

4.

Place the filled OpenArray™ plate in the QuantStudio™ 12K Flex OpenArray™
Plate Press 2.0.

Ensure that the bar code is facing left and the serial number is facing right.

Remove the clear plastic sheets from the top and the bottom of the lid, remove
the red protective film around the edge of the OpenArray™ lid, then seat the lid
on the OpenArray ™ case in the plate press.

(D Protective film (remove)

(2 Adhesive

(3 Protective film (remove)

(® Notched end (align with serial number)

Engage the press mechanism until the green flashing light changes to a steady
green light (~20 seconds).

Disengage the press, then remove the OpenArray™ case.
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with OpenArray™ plates
Run the OpenArray™ plate(s] on the QuantStudio™ 12K Flex instrument

5. While holding the OpenArray™ case
by the edges, insert the prepared
syringe tip into the port in the case,
then carefully inject immersion fluid
until the case is filled.

Note: Minimize creation of air
bubbles when you dispense the
fluid; one small air bubble in the case
is acceptable.

6. While holding the case vertically,
remove the syringe tip, insert the
screw end of the OpenArray™ plug
into the port and rotate clockwise
until the black handle breaks off.

The syringe tip must be in front of the array
when filling the case with immersion fluid.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and
rotate the plug slowly.

7. Clean the case with a laboratory wipe that has been thoroughly sprayed with
ethanol, then dry the case with a clean laboratory wipe.

Run the OpenArray  platels) on the QuantStudio 12K Flex
instrument

1. On the instrument touchscreen, touch [ to extend the loading arm, and place
the OpenArray ™ plates on the plate adapter.

Ensure that the plate barcode and serial number are facing the front of the
instrument.

2. Touch [ to retract the loading arm.

3. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, select
Run » OpenArray.

4. In the Select Instrument pane, select your QuantStudio™ instrument.

5. Click Get Plate IDs to import the barcode(s) of the OpenArray"™ plate(s).

Once the OpenArray™ serial numbers appear, the loaded *.tpf files
corresponding to each plate should appear in the Setup File field.

If not, click Browse, then select the correct loaded *.tpf file from the Loaded TPF
folder.

6. (Optional) Click Browse to change the QuantStudio™ Experiment File Location.
7. (Optional) Change the software-determined Experiment File Name.

8. C(lick Start Run.

Note: The instrument pauses at 41 or 42 seconds prior to the end of the run. Wait
for the system to complete the run before opening the *.eds file.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
Check the QC images

9. Transfer the *.eds file from the instrument to an accessible location for analysis.

10. Check the QC images for loading issues or leaks.

Check the QC images

Check the QC images before analysis. For additional information, see Appendix A,
“Troubleshooting”.

1. In the QuantStudio™ 12K Flex Software Export screen:
a. Click Browse to create a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Create a new folder for images each time; exporting a second run
to the same folder overwrites the images.

2. View the following ROX™ image to check for loading quality issues:
e POST-READ_CHANNEL_4.tiff

3. Check for leaks or other displaced sample issues.
a. View the following spotfinding images:
e 502_c001_t03_p0001_m1_x2_el_cp#_spotfind.tiff
e s502_c040_t03_p0001_m1_x2_el_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to the array position (1-4)
within the instrument.

b. If a problem is found, view the following pre-run spotfinding image to
determine if the issue existed even before cycling (this is useful for
troubleshooting):

¢ 500_c001_t01_p0001_m2_x3_el_cp#_spotfind.tiff

4. View the following FAM™ images to check for any fluorescent abnormalities and
to confirm any problem seen in the spotfinding images:

e STAGE2_CYCLE1_CHANNEL_L1.tiff
e STAGE2_CYCLE40_CHANNEL_1.tiff

5. Note any abnormalities found, as well as all other potentially relevant
information related to the setup of the run.
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Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
Recover from layout errors in the 384-well sample plate

Recover from layout errors in the 384-well sample plate

After the AccuFill” procedure, you can recover from plate layout errors that were ‘
made during setup of the reactions in the 384-well sample plate. See the OpenArray
Sample Tracker Software Quick Reference (Pub. No. 4460657) for additional information.

1. Create a corrected sample *.csv file.
2. Repeat “Generate 384-well sample plate layouts in the OpenArray™ Sample
Tracker Software” on page 23, but select OpenArray Plate X (for QuantStudio)

when exporting from the OpenArray™ Sample Tracker Software.

3. Import the corrected *.csv file into the QuantStudio™ 12K Flex Software.

Note: You can import either before starting the run or after the run is complete.

One-time procedures

Set up default This procedure simplifies the file locations used in the OpenArrayW AccuFill™
folders and instrument software.

software Set up the default file locations and preferences before using the OpenArray
preferences AccuFill”™ system for the first time. You must be logged in as an administrator.

1. Create the following four folders in a convenient location on the same computer

drive as the AccuFill™ software:
e TPF Files
¢ Sample Tracker 96-well Input
* Sample Tracker 384-well CSV Files
* Loaded TPF Files

2. (Optional) Navigate to <drive>: \Program files (x86)\
AppliedBiosystems\OpenArray Sample Tracker\Examples, copy the
96-Well Sample Plate 1.csv file, then paste it in the Sample Tracker 96-well Input
folder.

3. In the OpenArray™ Sample Tracker Software, select View » Preferences, then
enter the following preferences:

Field Selection
Experiment Type Gene Expression
OpenArray” Plate Select the OpenArray™ format that will be run
most often; for example, Gene Expression - 56
Pipettor Fixed or Adjustable
Import Data Directory Sample Tracker 96-well Input
Export Data Directory Sample Tracker 384-well CSV Files

4. In the AccuFill™ software, select Instrument » Edit Preferences, then:
a. Select Require Sample Integration.
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Download *.tpf
files

Chapter 4 Prepare and run vaginal microbiota profiling experiments
with OpenArray™ plates
One-time procedures

b. Select the indicated folders.

AccuFill” folder Default folder Folder contents
OpenArray” Plate TPF Files *.tpf files for the
File Input Folder OpenArray™ plates; contain

assay name and location

Sample Plate File Sample Tracker 384-well *.csv 384-well sample plate

Folder CSV Files layout files
Loaded OpenArray” | Loaded TPF Files Integrated *.tpf files that
Plate File Folder are generated during

processing with the
AccuFill"™ software.

5. In the QuantStudio™ 12K Flex instrument software, select

Tools » Preferences » OpenArray, then select the Loaded TPF Files folder for the
software Setup Folder.

™

Note: If the instrument software is not on the same computer as the AccuFill
software, transfer the loaded *.tpf files to the computer running the instrument
software.

Set up the optimized folder locations and software preferences before downloading
* tpf files. See “Set up default folders and software preferences” on page 30.

For custom OpenArray  plates, you need the Lot# and the Serial# from the packaging
of each OpenArray  plate.

1.

At www.thermofisher.com/OA-platefiles, select TagMan® OpenArray™ Custom
Gene Expression/Genotyping Plates in the Select Your Product dropdown list.

Select a download option:
* I want to download all available TPF & AIF files
* I want to download a specific TPF file

Enter the Lot# and the Serial#, then click Submit.

Note: The Serial# is case-sensitive.

Save the *.tpf files to the desktop TPF Files folder.

Note: Do not create sub-folders in the TPF Files folder. The software cannot
access sub-folders.

Vaginal Microbiota Profiling Experiments Application Guide 31


http://www.thermofisher.com/OA-platefiles

Export data

Export and review vaginal
microbiota profiling data

B Exportdata ............... ... 32
B Prepare exported data foranalysis ............. ... ... ... L. 32
B Reviewresults .......... ... .. 33
1. Open an *.eds file in the QuantStudio™ 12K Flex Software.
2. In the Experiment Menu pane, click Export.
3. Click Load Export Set (bottom of the screen), select GE_export_setting, then click
OK.
4. Select .xIsx from the File Type dropdown list (top-right of the screen).
5. (Optional) Perform any of the following actions to customize the file export:
¢ Select Open file(s) when export is complete.
¢ C(lick Browse to select a new Export File Location.
¢ Enter a new file name in the Export File Name text field.
¢ (lick the Results tab, then select the content to export.
6. Click Start Export (bottom of the screen).

If Open file(s) when export is complete is selected, then the file automatically
opens. If the option is not selected, navigate to and open the exported *.xIsx file.

Prepare exported data for analysis

32

1.

2.

Open the exported *.xlsx data file.

Ensure that the barcode, run conditions, and all selected data columns were
exported correctly.

Scroll down to the data rows, select the headers and data, then copy-paste into a
new worksheet.

Rename the new worksheet Data Table_Run File Name.
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Chapter 5 Export and review vaginal microbiota profiling data
Review results

5. (Optional) To combine data from multiple OpenArray™ plates:

M

a. Insert a Barcode column in the Data Table worksheet to track OpenArray’
barcodes.

b. Copy-paste the barcode numbers to the appropriate cells in the new Barcode
column.

6. Find-replace all "Undetermined" values with an empty cell (no value) in the C
column.

This step ensures an exact count of C,; values.

7. Delete rows that do not contain run data.

Review results

Review the exported data for through-hole results that may require special attention.

* Consider omitting through-holes with the following values:

Parameter to
examine

Crt Cri 231
Cq Confidence Cq Conf<0.8

Consider omitting through-hole if...

Note: Possible exceptions could include:

+ 16s rRNA (Ba04930791_s1) — acceptable range is 0.7 -1.0
* RNase P (Hs04930436_g1) — acceptable range is 0.7 - 1.0

Amp Score Amp Score < 1.24

Note: Possible exceptions could include:
+ G. vaginalis (Ba04646236_s1)—acceptable range is 1.1 -1.6

¢ Take note of technical replicates with mean C,; < 25 and a high standard
deviation (> 0.5). The data from these technical replicates may require further
review.

e Ensure that two of the three replicates amplified adequately and passed your
review specifications.

Note: We recommend three technical replicates of each reaction.

Use your preferred method to analyze the data.
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Review results

To review results using pivot tables, you can use the following settings.

Fields for
reviewing results Note: For the "Average of" and "StdDev of" summarizations, use the appropriate
with pivot tables source field (C, Amp Score, or Cq Conf), then choose the calculation type.

Fields to add

Area of pivot table
Target-oriented view Sample-oriented view

Report Filter — Sample Name!"!

Column Labels Sample Name —
Row Labels Target Name Target Name
Values Average of Cp Average of Cp
StdDev of Cy{2 StdDev of C4{2

Count of C Count of C

— Average of Amp Score

— Average of C Conf

[ To see individual sample results, select the sample from the dropdown list next to the Sample Name header.
(21 AValues field will automatically appear in the Column Labels area.
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Troubleshooting

Troubleshoot DNA isolation errors ..., 35
Troubleshoot with cycling and imaging runimages ....................... 36
AccuFill™ instrument plate loading errors .............. ..., 37
OpenArray™ plate assembly and handling errors ........................ 38

Troubleshoot DNA isolation errors

Observation Possible cause

Recommended action

ESwab™ samples appear cloudy | Samples have been stored for
or dense more than 48 hours (at room
temperature or lower).

Note: With extended storage,
samples become more viscous
which can cause the DNA
Binding Beads to clump. DNA
recovery may be reduced,
impacting downstream
performance.

Modify the DNA isolation protocol to improve
DNA recovery:

1. Reduce the sample volume to 150-200 pL
in “Concentrate the samples” on page 16.

2. Increase the volume of both DNA Elution

Buffers to 50 L in “Set up the processing
plates” on page 18.
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Appendix A Troubleshooting
Troubleshoot with cycling and imaging run images

Troubleshoot with cycling and imaging run images

Many problems with OpenArray  results can be diagnosed by examining the quality
control (QC) images taken at various points during a cycling/imaging run.

The QC images are fluorescent or reflected light images taken before, during, and
after cycling. They may require adjustment to make image features visible. To view
the images, we recommend that you install the free software program Image]J, which
allows you to easily manipulate the images in ways that other image viewers cannot.

1. In the QuantStudio™ 12K Flex Software

Export screen:

a. Click Browse to select a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Select a new folder for images each time; exporting a second run

to the same folder overwrites the images.

2. Use Image] to view the images of interest.

To...

View image...

Image description

Confirm the identity of
images within a folder

BARCODE IMAGE.tiff

Reflected light image of the entire
OpenArray” plate

Evaluate the loading
quality

PRE-READ_CHANNEL_A4.tiff
POST-READ_CHANNEL_4.tiff

Pre- and post-ROX" images

Check for existing
contamination on the
case and/or heated
cover

s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiffl!]

Pre-run reflected light spotfinding
image (used by the software to
determine the location of the holes)

Identify potential leaks
or other contamination

s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!!

Mid-run reflected light spotfinding
image

s02_c040_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!]

Post-run reflected light spotfinding
image

Look at patterns in the
fluorescent data (for
example, gradients)

STAGEx_CYCLEy_CHANNEL_1.tiff

FAM™ images at a particular cycle
ly) of a particular stage (x) of the
run.

01 The “cp#” in the image file name refers to the array position (1-4) within the QuantStudio™ 12K Flex instrument.

36

3. (Optional) Adjust the images for brightness and/or contrast to make image

features visible.

a. Open the image in Image].

b. Select Image » Adjust Brightness/Contrast (or press Ctrl+Shift+C).

c. Click Auto or adjust the sliders until the features of interest in the image are

visible.
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AccuFill™ instrument plate loading errors

AccuFill” instrument plate loading errors

Observation

Possible cause

Recommended action

There are empty through-holes

Insufficient sample was
added to the 384-well sample
plate.

Use proper pipetting
techniques. Ensure that there
are no air bubbles in the
pipette tips after sample
aspiration.

Reaction mix [sample +
master mix] is not at the
bottom of the 384-well
sample plate.

Centrifuge the sample plate
at 1,000 rpm for 60 seconds.

Turn-holes are repeatedly missed

AccuFill™ instrument is
aligned too far to the left or to
the right.

Systematic loading problems
can occur with the AccuFill"™
instrument, which indicates a
need for service. For example,
when turn-holes are
repeatedly missed across
multiple subarrays, service is
required. Turn-holes are
where the AccuFill™
instrument changes direction
during sample loading.

0,690 06,0
0/ 0]0 0)0/0]0®
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0,0]0 @)
Q006000

@ Turn holes
O start points
@ Stop points

Contact your local field
service engineer.

Entire subarrays are missing

The sample/master mix not
added to particular wells in
the 384-well sample plate.

Visually inspect the sample
plate to ensure that the wells
have sample/master mix.

Stuck tip mandrel on
AccuFill™ instrument may
need cleaning.

Contact your local field
service engineer.

Pipette tip not loaded on
mandrel.

Contact your local field
service engineer for frequent
occurrences (infrequent
occurrences can be due to a
poorly molded tip).
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OpenArray™ plate assembly and handling errors

OpenArray plate assembly and handling errors

Observation

Possible cause

Recommended action

Case leaks and bubbles inside the case

Improper sealing of theOpenArray™ plate in the
OpenArray™ Case can lead to immersion fluid
leaks or bubble formation inside the case, leading
to uneven heating and imaging throughout PCR
and to poor quality genotyping data.

The images above are examples of OpenArray™
plates that have been affected by immersion fluid
leaks. The images show where leaked fluid has
condensed on the underside of the heated cover
windows and obscured the view of the through-
holes.

The best image in which to detect leaks is the
s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
image. This image is taken at the start of cycling,
which is where most leaks occur. See
“Troubleshoot with cycling and imaging run
images” on page 36.

Plate press was not engaged
for at least 20 seconds.

Fully engage the plate press
for at least 20 seconds.

Damaged lid adhesive.

Remove the liner and visually
inspect the lid adhesives for
defects. Ensure that adhesive
is not damaged or warped.

Damaged fill port screw
gasket.

Visually inspect the screw to
ensure that the orange gasket
is present and not damaged.

Damaged fill port screw
assembly. Breaks off too
easily.

The screw may be mis-
threaded: Unscrew it and use
a new screw assembly.

Oily lid or case from
immersion fluid overflow.

Wipe off excess overflow of
immersion fluid from the lid,
case bottom, and crevices
with 70% isopropyl alcohol,
using a lint-free cloth (the
cloth included with the
OpenArray™ plate is
acceptable).

Immersion fluid exposed to
air for too long.

Do not remove the immersion
fluid syringe cap or draw air
bubbles into the syringe until
you are ready to load. Do not
draw air bubbles into the
syringe.

Too large of a bubble inside
the OpenArray™ case after
sealing.

Minimize the size of the
bubble by tilting the
OpenArray™ case so that the
fill port is at the highest point.
Slowly fill the case with
immersion fluid until only a
small air bubble remains.
Attach the screw and wipe off
any excess oil that may have
spilled onto the case.

Damaged plate press leading
to uneven pressure.

Contact your field service
engineer if you suspect that
your plate press may be
damaged.

38
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OpenArray™ plate assembly and handling errors

Observation

Possible cause

Recommended action

Sample blow out during the addition of immersion
fluid

The reactions in A12 were
compromised during the
addition of immersion fluid.
Injecting the immersion fluid
too quickly can actually purge
the sample out of the
through-holes near the fill
port. Often this is caused by
the user not purging the
syringe slightly before use.

Dispense a small amount of
immersion fluid onto a paper
towel before use to ensure
smooth operation of the
syringe.

Evaporation of reaction mixture in through-holes

Too much time elapsed before
plate was sealed with lid and
immersion fluid. In this
example, the top half of each
subarray was intentionally left
open to the environment to
demonstrate the effect of
evaporation. “Donuts” are a
result of the evaporated fluid
in the though-holes.

Add immersion fluid as soon
as the case is removed from
the plate press to minimize
the likelihood of evaporation,
then seal the case with the
lid.
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Isolate DNA using the MagMAX"™
DNA Multi-Sample Ultra Kit:
Hologic" Aptima media

Procedural guidelines ........ ... ... ... .. . 41
Before firstuseof the kit ............ ... ... ... 41
Digest the samples with the Preliminary Digestion Mix .................... 42
Digest the samples with Proteinase K . ...................... ... ... ... 42
Set up the processing plates ............ ... ...l 43

Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix, and isopropanol .. 44

Process samples on the instrument ................... ... ... oL 44

These are modified instructions specific to samples collected using the Hologic™

Aptima™ Vaginal Swab Transport Media (STM). This modified protocol does not
include a preliminary concentration of samples, so increased volumes of PK Buffer
and binding reagents are required.

See Chapter 3, “Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit“ for
information on:

¢ Kit contents and storage (page 12)

* Materials and equipment required but not supplied (page 13)
e Downloading the KingFisher™ Flex program (page 14)

* Setting up the sample layout (page 16)

See the collection system or media documentation provided by the manufacturer for
information on sample collection and storage.
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Appendix B Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra
Kit: Hologic™ Aptima™ media
Procedural guidelines

Procedural guidelines

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

* See the collection system or media documentation provided by the manufacturer
for information on sample collection and storage.

¢ Perform all steps at room temperature (20-25°C) unless otherwise noted.
* Preheat an incubator to 65°C before each use of the kit.
* When mixing samples by pipetting up and down, avoid creating bubbles.

¢ Cover the plate during the incubation and shaking steps to prevent spill-over and
cross-contamination. The same MicroAmp"™ Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.

¢ If you use a plate shaker other than the recommended shaker, verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

¢ To prevent evaporation and contamination, cover the prepared processing plates
with paraffin film until they are loaded into the instrument.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and
add 5% overage.

¢ For convenience, you can extend the Proteinase K digestion to 30 minutes.

Before first use of the kit

* Prepare the Wash Solutions from the concentrates:

— Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at
room temperature.

— Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at
room temperature.

* Reconstitute the zymolyase with 500 uL of the provided storage buffer (final
concentration of 4 U/uL), vortex to mix, then store at —20°C.

See the documentation provided with the zymolyase for more information.
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Appendix B Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra

Kit: Hologic™ Aptima™ media
Digest the samples with the Preliminary Digestion Mix

Digest the samples with the Preliminary Digestion Mix

1.

Prepare sufficient Preliminary Digestion Mix according to the following table.

IMPORTANT! Prepare the Preliminary Digestion Mix no more than 30 minutes
before use and store on ice. Prolonged storage at room temperature can reduce

its efficiency.

Component Volume per well | Volume per plate
B-PER" Bacterial Protein Extraction 185 L 18.5 mL
Reagent
Lysozyme Solution 10 L 1 mL
Zymolyase solution (4 U/pL) 5uL 0.5mL
Total Preliminary Digestion Mix 200 pL 20 mL

Invert the sample collection vial 5 times to ensure thorough mixing of the

sample.

Following the sample layout, transfer 200 uL of sample to the appropriate wells

of a deep-well plate.

Add 200 pL of Preliminary Digestion Mix to each sample well.

Seal the plate with a clear adhesive film, then shake for 2 minutes at 1,050 rpm.

Incubate the plate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation

temperature.

During the incubation, prepare the PK Mix (next section).

Digest the samples with Proteinase K

42

1.

Prepare sufficient PK Mix according to the following table, then invert several

times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix no more than 30 minutes before use and store
at room temperature. Do not place PK Buffer or PK Mix on ice, to avoid

precipitation.
Component Volume per well Volume per plate
Proteinase K 8 uL 0.8 mL
PK Buffer 72 uL 7.2 mL
Total PK Mix 80 uL 8.0 mL

When the incubation with Preliminary Digestion Mix is complete, add 80 uL of

PK Mix to each sample well of the plate.
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Appendix B Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra
Kit: Hologic™ Aptima™ media
Set up the processing plates

3. Seal the plate with a clear adhesive film, then shake the sealed plate for 2 minutes

Set up the processing plates

1.

at 1,050 rpm.

Incubate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation

temperature.

While the samples are incubating at 65°C, set up the Wash, Elution, and Tip
Comb Plates outside the instrument as described in the following table.

Plate ID po:ilt?;?nm Plate type Reagent Volt‘an;flper
Wash Plate 1 2 Deep Well Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well Wash Solution 2 150 pL
Wash Plate 3 4 Deep Well Wash Solution 2 150 pL

T R e T

Tip Comb 6 Deep Well Place a tip comb in the plate.

1 Position on the instrument

(2 The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with
DNA Elution Buffer 1.

(Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.
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Appendix B Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra
Kit: Hologic™ Aptima™ media
Add Multi-Sample DNA Lysis Buffer;, Bead/RNase A Mix, and isopropanol

Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix, and

isopropanol

. (Optional) If condensation is present at the end of the 65°C incubation, briefly

centrifuge the plate for 1-2 minutes at 1,500 x g.

Prepare sufficient Bead/RNase A Mix according to the following table.

IMPORTANT! Prepare the Bead/RNase A Mix no more than 1 hour before use
and store on ice. Prolonged storage at room temperature can reduce its efficiency.

Vortex the DNA Binding Beads at moderate speed to form a uniform suspension
before preparing the Bead/RNase A Mix.

Component Volume per well Volume per plate
DNA Binding Beads 16 L 1.6 mL
RNase A S5uL 0.5mL
Nuclease-free Water 19 uL 1.9 mL
Total Bead/RNase A Mix 40 pL 4.0mL

Add 200 pL of Multi-Sample DNA Lysis Buffer to each sample.

Vortex the Bead/RNase A Mix at moderate speed to ensure thorough mixing,
then add 40 pL to each sample.

If you see that the beads in the Bead/RNase A Mix are settling, vortex the mix
again briefly before continuing to pipette.

Add 315 pL of isopropanol to each sample, then proceed immediately to process
the samples on the instrument (next section).

Process samples on the instrument

1.

44

Select the program on the instrument.

™

¢ KingFisher™ Flex Magnetic Particle Processor: A25597_Vaginal
* MagMAX"™ Express-96 Magnetic Particle Processor: 4413021_DW_blood

Start the run, remove the temporary paraffin plate seals (if present), then load the
prepared processing plates in their positions when prompted by the instrument.

Load the sample plate (containing lysate, isopropanol, and Bead/RNase A Mix)
at position 1 when prompted by the instrument.

When prompted by the instrument (approximately 25 minutes after initial start):

a. Remove the Elution Plate from the instrument.
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Appendix B Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra
Kit: Hologic™ Aptima™ media
Process samples on the instrument

b. Add 30 uL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.

5. At the end of the run (approximately 30 minutes after initial start), remove the
Elution Plate from the instrument and seal immediately with a new clear
adhesive film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

* If you see excessive bead residue in the wells, place the Elution Plate on the
Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

e At 2-6°C for up to 24 hours.
* At -20°C or -80°C for long-term storage.
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Safety

A WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Appendix C Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

- Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

Biological hazard safety

48

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities
with the appropriate safety equipment (for example, physical containment
devices). Safety equipment can also include items for personal protection, such
as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety
glasses, or goggles. Individuals should be trained according to applicable
regulatory and company/ institution requirements before working with
potentially biohazardous materials. Follow all applicable local, state/provincial,
and/or national regulations. The following references provide general
guidelines when handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document Publication Number
Isolation of DNA for Vaginal Microbiota Profiling Experiments Quick Reference MANO0015935
OpenArray” Vaginal Microbiota Profiling Experiments Quick Reference MANO0015936
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray" Experiments User Guide 4470935
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” AccuFill" System User Guide 4456986

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including;:

* Worldwide contact telephone numbers

* Product support, including;:
— Product FAQs

— Software, patches, and updates
¢ Order and web support

* Product documentation, including:
— User guides, manuals, and protocols

— Certificates of Analysis

— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,

contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life

Technologies at www.thermofisher.com/support.
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